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eCoordinator Reporting 
eCoordinator has very little reporting capability.  Because of this, grid views and filters have to be used within 

eCoordinator to organize data into useful information.  Often data has to be moved out of the system and into 

other applications for processing.  The examples in this document show how to use eCoordinator and 

Microsoft Excel to answer questions from your chapter partners, volunteers and board. 

Return to the Table of Contents 

Using this Guide 
Start by going through the Chapter Roster Report example first.  This report goes through all the steps 

necessary to move data out of eCoordinator and into Microsoft Excel using the eCoordinator Data Grid Report.  

This process is call exporting.  The exporting process is not repeated in the other examples because the steps 

are the same. 

Return to the Table of Contents 

Member Reporting 

Chapter Roster Report 
Begin by logging into eCoordinator and selecting your chapter folder.  In this example we’re working in the 

Mid-Coast folder. 
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Select the TMN Standard – Chapter Member Summary grid view from the Grid View selection dropdown box.  

This view contains all of the data columns needed for the Roster Report.  Click on the Reports button. 

 

Select Volunteer Data Grid from the Report button dropdown list. 
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The report parameters window is shown.  Exclude the columns not needed in the roster report by checking the 

boxes to the right of the field names.  In this example the Last Name, First Name, Home Phone, Cell Phone, 

Email Address, Street Address, City, Zip, and Master Naturalist Class are the only fields needed on the report.  

The rest of the fields will be excluded.  After excluding fields, select the Excel (*.xlsx) item on the Report 

Format dropdown list.  Note: the resulting export file will be named using the Report Title on this window. 

 

Click the OK button. 
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Depending on which internet browser software you are using the window shown below may be different.  The 

purpose of this step is to save the data file from eCoordinator to your computer.  In this example Internet 

Explorer is being used.  Save the file and note where it is located on your computer.  Often, the default folder 

is your Downloads folder.  Google Chrome has a feature that shows the folder in which the file has been saved.  

If you are using Google Chrome you can select Show in Folder to get this information. 
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The file has been saved in the desktop folder and is named TMN_Standard_Chapter_Member_Summary.xlsx 

 

Click the Close button to return to the volunteer view. 
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Open Microsoft Excel and choose Open Other Workbooks. 

 

Select the Browse button. 
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Navigate to the location where the file was saved earlier.  In this example, the file was saved in the desktop 

folder.  Select your file and click on the Open button. 

 

 

Now the information from eCoordinator is in Excel.  Expand the column widths so that you can see the 

information.  Select the FILE menu option at the top left of the screen to begin formatting and finishing the 

report. 

 

Select the Print option. 
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Select Page Setup. 
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On the Page Setup | Page tab click on the Orientation Landscape radio button.   

 

 

Select the Page Setup | Header/Footer tab. 
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Click on the Custom Header button. 

 

Type the name of your report.  In this example, the title is Mid-Coast Chapter Roster.  Click the OK button 

when finished. 
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Select the Page Setup| Sheet tab.  Click on the Print Gridlines checkbox.  

 

Click on the OK button. 
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From the Scaling dropdown list select the Fit All Columns on One Page.  Note: this can also be accomplished on 

the Page Setup window. 
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Choose Microsoft Print to PDF selection from the Printer dropdown list.  Click on the Print button to create the 

report. 

 

The Save Print Output As window opens.  Name your file and save it by clicking the Save button.  Note the 

location. 

 

 

  



15 
 

The completed report can now be view in Acrobat Reader or other PDF viewing software. 

 

You can use this same process to create a volunteer phone list and meeting sign in sheet. 

Return to the Table of Contents 

  



16 
 

Dues 
Begin by logging into eCoordinator and choosing your chapter folder.  In this example we’re working with the 

Mid-Coast chapter.  Select the Volunteer tab and the TMN Standard grid view from the dropdown list. 

 

Click on the Filters button. 
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The Filters window is displayed.  Click on the New button. 

 

The New Filter window is displayed. 
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In this case we are creating a filter for TMN-Active volunteers who have not paid 2018 dues.  As a reward for 

service, the Mid-Coast chapter does not require volunteers with over 5,000 service hours to pay dues.  Enter a 

name and description for your search. 

 

Now we need to find our requirements fields.  Expand the User Defined Fields list on the left. 
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Expand the Certifications group list. 

 

Scroll down the list until you find Certifications under the User Defined Fields list.  Scroll down the 

Certifications list until you find the Certifications/ Master Naturalist Certifications Level.   Hint: when looking 

for fields, think about where they appear in the Volunteer Profile.  The dues field is located on the User 

Defined tab, in the Certifications group on the Volunteer Profile.  Click on the Certifications/Master Naturalist 

Dues listing to show the qualifications options.  Select equals and the option TMN-Active.  Click the Save 

button. 
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Click the AND and ( buttons. 

 

Scroll down the list until you find Certifications under the User Defined Fields list.  Scroll down the 

Certifications list until you find the Certifications/ Master Naturalist Dues listing (near the bottom of the list).   

Click on the Certifications/Master Naturalist Dues listing to show the qualifications options.  Select does not 

include and enter 2017.  Click on the Save button.  Remember that we’re looking for TMN-Active volunteers 

who do not have 2017 in their dues field.  
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Click the OR button. 

 

In the Mid-Coast chapter volunteers with >= 5,000 service hours are not required to pay dues.  To eliminate 

them we populate the dues field with the year 2025.  If your chapter does not do this then skip to the Filter 

saving step.   

Click the OR button.  Add the qualifiers for the 2025 year just like 2017.  Click the ) button. 
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This is the result we’re looking for: 

 

Save your work.  Scroll down to the bottom of the page and click the OK button. 
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Now we have a new Filter.  Click on the Close button to close the window. 

 

When the Filters window closes we return to the Volunteer grid.  Click the Grid Settings Button. 
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The Grid Settings for Volunteers window is shown. 

 

Our focus is on dues for our new grid view.  Begin by holding the Ctrl key on the keyboard and clicking the User 

ID, Age, TMN Officers/Committees/TMN Officer List, TMN Officers/Committees/ TMN Committee, 

Certifications/ Current Chapter, and Gender selected columns fields as shown below.  Click on the << button to 

return these fields to the Available Columns list.   

 



25 
 

Now we have selected the columns that we want for our resulting grid with one exception, the Dues field.  

Expand the VOL: Certifications group in the Available Columns list. 

 

Scroll down until you find the Certifications/Master Naturalist Dues field in the list.  Click on it to highlight and 

then click the >> button to add it to the Selected Columns list. 
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The Dues field is now in the Selected Columns List. 
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Click on the Currently Selected Folder checkbox and select your chapter from the Chapter dropdown list.  Click 

on the Currently Selected Filter dropdown list and select the Filter that you saved previously.  In this case we 

are using the Dues Check Filter. 
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Now we need to save the grid under a new name.  Click in the Save As name text box and type a new name.  

Then click the save button. 

 

This example is saved as Dues Check.  Click the OK button to return to the Volunteer tab. 
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The resulting grid view is a list of our TMN-Active volunteers who have not paid their 2018 dues.  Note that the 

Dues Check grid view and Dues Check Filter are being used. 

 

Return to the Table of Contents 

Certifications, Volunteer Counts and Hours Reporting Percentages 
Begin by logging into eCoordinator and choosing your chapter folder.  In this example we’re working with the 

Mid-Coast chapter.  Select the Volunteer tab and select the TMN Standard grid view from the dropdown list. 
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Select the TMN Standard grid view from the Grid View selection dropdown list.  Select the TMN-Hours Entry 

Eligible Filter from the Filters dropdown list.  The resulting grid shows the TMN-Active and TMN-InTraining 

volunteers excluding TMN-Inactive, TMN-Interested, and TMN-Not Eligible. 

 

The Mid-Coast chapter has 85 volunteers who meet the Hours Entry Eligible criteria. 
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Select All volunteers in Grid option. 

 

 

Note: Approve all hours before checking certifications and milestones. 
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The eCoordinator Log Book System window is displayed.  Check that you have All Log Book entries selected.  

Check the date range.  In this example we are checking for certifications in 2018.  The date range has been set 

to January 1, 2018 through December 31, 2018.  Click the Apply button to apply the settings to the grid. 

 

Click the Show All button and then select TMN Standard-Awards & Recertification from the Grid View 

dropdown list.  Note: Selecting this  
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Now we are looking at all volunteers who report hours in 2018 with TMN Hours summarized and sorted in 

descending order.  Note: this will not include hours from volunteers who transferred to another chapter.  The 

light blue background signifies that the grid is in summary mode.  Sixty-nine volunteers have reported hours in 

2018 (number of rows).  So 81% of the Mid-Coast hours entry eligible reported some hours in 2018  (69 

volunteers reporting hours divided by 85 hours entry eligible volunteers from the row count of the Volunteer 

tab equals 81% reporting hours for 2018). 

 

Click on the = dropdown list on the left side of the TMN Hours Find grid row.  Select >=. 
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Enter 40 in the right side.  Select the >= from the dropdown list under AT Hours and enter 8 in the text box.  

Click the Find button.  Our list now shows only those volunteers who had greater or equal to 40 hours of 

service and greater than or equal to 8 hours of advanced training hours in 2018.  With the current hours 

eligible count of 85, the Mid-Coast chapter had 69% of volunteers who certified in 2018.    (34 certified rows in 

the grid divided by 85 hours entry eligible from the row count of the volunteer tab= 40% certified for 2018).  

This is a low average for the Mid-Coast chapter.  Hurricane Harvey had an effect on volunteering and reporting. 

 

Check the Master Naturalist Cert Date column to see which volunteer profiles you need to update.  Tip: Use 

automation to update these as a group instead of having to update each volunteer profile. 
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In summary the Mid-Coast chapter had: 

85 volunteers who met the hours entry eligible criteria (current year) 
69 volunteers who reported hours in 2018 
69 reporting hours divided by 85 hours entry eligible equals 81% reporting hours for 2018 
34 Volunteers who certified 
34 volunteers who certified divided by 85 hours entry eligible volunteers equals 40% certified for 2018 
Return to the Table of Contents 

Milestones 
Begin by logging into eCoordinator and choosing your chapter folder.  In this example we’re working with the 

Mid-Coast chapter.  Select the Volunteer tab and select the TMN Standard grid view from the dropdown list. 
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Select the TMN Standard grid view from the Grid View selection dropdown list.  Select the TMN-Hours Entry 

Eligible Filter from the Filters dropdown list.  The resulting grid shows the TMN-Active and TMN-InTraining 

volunteers excluding TMN-Inactive, TMN-Interested, and TMN-Not Eligible. 

 

The Mid-Coast chapter has 85 volunteers who meet the Hours Entry Eligible criteria.  Make a note of this 

number for your volunteers reporting calculation later.  Select the Log Book Button. 
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Select All volunteers in Grid option. 

 

 

Note: Approve all hours before checking certifications and milestones. 
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The eCoordinator Log Book System window is displayed.  Check that All Log Book entries are selected.  Select 

Relative date range.  In this example we are checking for milestones.  Choose All Time from the Period 

dropdown list.  Click the Apply button to apply these settings to the grid. 

 

Select the TMN Standard-Awards 00250 Hours grid view. 
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We are now looking at volunteers with cumulative service hours >= 250 but less than 500.  Look for anyone 

who has an empty date in the 250 Hrs Award Date column. 

 

Check each of the milestone levels in the grid view dropdown list 20000, 15000, 10000, 5000, 4000, 2500, 

1000, 500, and 250 and then their corresponding Awarded Date and Hours Award (Yes/No) columns to see if 

the volunteer profiles have been updated. 

Tip: Check the ones that require updating and run a Logbook Data Grid Report.  Exporting the data will give 

you a list of volunteers to update. 

Return to the Table of Contents 
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Interests 
Often a chapter is looking for volunteers with a particular skillset.  Checking volunteer Work History and 

Experience could be just the answer.  Begin by logging into eCoordinator and choosing your chapter folder.  In 

this example we’re working with the Mid-Coast chapter.   

 

 

Select the TMN Standard grid view from the dropdown list.  Click on the Grid Settings button. 
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The Grid Settings for Volunteers window is shown.  Expand the Vol: General field list and click on General/ 

Work History/ Experience.   Click the >> button to move it to the Selected Columns list. 

 

Position it to the third column position by selecting it and then click the Move Up button. 
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Type a name for the new grid setting and click on the Save button.  Click OK to return to the Volunteer tab 

using the new grid view. 

 

Using our new grid view, Work History/ Experience has now been added in the third column position in the 

grid.  Review the Work History/ Experience column to see if the skillset you need is listed. 

 

Return to the Table of Contents 
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Class Listing 
Begin by logging into eCoordinator and selecting your chapter folder.  In this example we’re working in the 

Mid-Coast folder and we want a listing of the volunteers in the 2016 class. 

Select the TMN Standard – Chapter Member Summary grid view from the Grid View selection dropdown box.   
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Since some of the 2016 class may no longer be active we need to include them in the grid.  Do this by selecting 

the Clear Filters button.  Now the grid has all of the chapter’s historical volunteers who have not transferred 

out of the chapter.  Click the Grid Settings button. 

 

The Grid Settings for Volunteers is shown.  Scroll down the Selected Columns list and find the Certifications/ 

Master Naturalist Class column.  Type 2016 in the text box to the right of the class field. Click on the Apply 

button.  This applies the view to the Volunteer tab.  Since this will be a temporary view, click the Cancel button 

to return to the Volunteer tab.   
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When the Volunteer tab is shown again the 2016 class are the only volunteers in the list. 

 

Return to the Table of Contents 

Emailing Volunteer Milestones and Certification Progress 
Begin by logging into eCoordinator and choosing your chapter folder.  In this example we’re working with the 

Mid-Coast chapter.  Select the Volunteer tab and select the TMN Standard grid view from the dropdown list. 
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Select the TMN Standard grid view from the Grid View selection dropdown list.  Select the TMN-Hours Entry 

Eligible Filter from the Filters dropdown list.  The resulting grid shows the TMN-Active and TMN-InTraining 

volunteers excluding TMN-Inactive, TMN-Interested, and TMN-Not Eligible. 

 

Set the Relative Date Range to This Year to include hours reported in the current year.  Select TMN Standard 

Awards & Recertification from the Grid Settings dropdown list.  Finally, click the Email button. 
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The eCoordinator Volunteer Log Book Email window is shown.   
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Use the Saved Email Template List to select the TMN-Recertification Status template.  Click the Open button 

below the dropdown list. 
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Change the information in the template to your contact information and signature.  Use the Save Email 

Template text box to create a template with your information.  Prefix the name of the template with your first 

initial and last name.  You will use this new template for recertification email communication in the future.  

Click the Save button. 
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Click the Preview button.   
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The eCoordinator Email Preview window is shown.  This is what your email will look like when sent to the 

volunteers in your list.  Click the Close button. 
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When you are satisfied with your email, click the Send button.  This will send an individualized email to each of 

the volunteers in your log book grid. 
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There is also template named TMN-Milestone Status for use in communicating volunteer cumulative and 

milestone dates.  Use the same steps above to customize and use this template.   

Return to the Table of Contents 

Chapter Reports 
Use the Opportunity tab for reporting cumulative hour totals for the chapter.  If you use the Volunteer tab you 

may be missing hours reported by volunteers who have transferred to other chapters.  Hours always stay with 

the opportunities. 

Hours by Category | Creating Pivot Tables and Charts in Excel 
In this example we will be gathering information out of eCoordinator and using it to report 2017 hours and 

impact data for the Mid-Coast chapter.  In addition, we will create a chart showing total hours spent in each 

opportunity category for the year. 

Log in to eCoordinator.  Choose your chapter folder.  In this example we’re using the Mid-Coast chapter.  

Select the Opportunity tab and the TMN Standard grid view.  Click the Log Book button and choose all 

opportunities in grid. 
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Set the date range (January 1, 2016 to December 31, 2016).  Click the Apply button.  Choose the TMN Standard 

Reporting grid view from the Grid View dropdown list.  Select Summary Mode. 

 

Click on the Reports button and choose Opportunity Data Grid. 
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The Report Parameters window is shown.    Type a name for your report in the Report Title text box.  Exclude 

the Start Date, Chapter Name, and Service Performed columns.  Since this is summary data those column 

values are N/A.  Choose Excel (*.xlsx) from the Report Format dropdown list.  Click the OK button to continue. 
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Depending on which internet browser software you are using the window shown below may be different.  The 

purpose of this step is to save the data file from eCoordinator to your computer.  In this example Internet 

Explorer is being used.  Save the file and note where it is located on your computer.  Often, the default folder 

is your Downloads folder.  Google Chrome has a feature that shows the folder in which the file has been saved.  

If you are using Google Chrome you can select Show in Folder to get this information.  Click the Close button 

when eCoordinator Log Book System window is shown again. 

 

 

 

Open Excel.  Choose Open Other Workbooks. 
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Click the Browse button or choose the folder where your report file was stored.  Select your file and click the 

Open button. 

 

The report data is now in Excel. 
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Click the corner arrow to select all cells and drag the column divider to the right to widen the columns.  This 

will make it easier to see the information. 

 

Locate the total line at the bottom of the imported data.  You may want to print this line, it contains the total 

number of hours for each opportunity, number of volunteers reporting hours to each opportunity, hours’ 

totals for advanced training, initial training and service hours.  It also contains impact data for the date range 

including people touched by outreach activities, acreage, and new trail miles impacted. For this example we 

are going to delete the row.  Delete the summary row. 
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Highlight the cells containing data.  In this example, columns A-Q and rows 1-60.  Choose the Insert tab on the 

menu and then click the Pivot Table icon on the Ribbon Bar. 

 

The Create Pivot Table window is shown.  Check that New Worksheet is selected and click OK. 
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The new work sheet is shown with the pivot table. 

 

Click the “What category does the project fall under” checkbox to include this data in the table. 
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Position the mouse pointer over TMN Hours and right mouse click to show the Options dropdown list.  Choose 

the Add to Values option. 

 

 

Count of TMN Hours has been added to the table. 
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Position the mouse pointer over AT Hours and right mouse click to show the Options dropdown list.  Choose 

the Add to Values option. 

 

Count of AT hours has been added to the table. 

 

  



63 
 

Click Count of TMN Hours in the Sum Values box to show the Options dropdown list.  Choose the Value Fields 

Settings option. 
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We want the sum of TMN hours in our chart, but not the number of opportunities in each category.  When the 

Value Field Settings window is shown click Sum and then click on OK. 

 

Click Count of AT Hours in the Sum Values box to show the Options dropdown list.  Choose the Value Fields 

Settings option. 

 



65 
 

We want the sum of AT hours in our chart, but not the number of opportunities in the AT category.  When the 

Value Field Settings window is shown click Sum and then click on OK. 

 

Now we are showing total hours for each of the nine categories. 

 

  



66 
 

Select title row through the last category and the three columns.  Exclude the total line.   Right click and select 

Copy. 

 

Select the New Sheet option and add a new sheet to the workbook. 
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Select the newly created work sheet and right click on the new sheet and past the values into the sheet. 
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Adjust the column widths to see the data.  Rename the column headings as shown below. 
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Select the data cells in the worksheet. 

 

While the data cells are selected, choose the Insert tab on the menu and click on the Pie Chart icon on the 

Ribbon Bar.  Choose the 3-D Pie chart option. 
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Adjust the size of the chart by grabbing the corners with the mouse pointer and holding down the left mouse 

button.  Select the title box and type the title of your chart.  In this example we’re looking at the Mid-Coast 

2017 Hours by Category. 
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Click the Chart Elements + icon and expand the Data Labels selection.  Choose More Options. 

 

Format Data Labels is shown.  Choose the Category Name and Percentage check boxes.  Uncheck the value 

label.  Click the X at the top of the Format Data Labels box to close it. 
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We now have the category names and percentage of the total hours in our pie chart.  The legend at the 

bottom of the chart is redundant.  Right mouse click on it and choose the delete option. 
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The chart is complete.  If the text is hard to read within a slice.  Drag it to an area where it is easier to read. 

Let’s move it to something easier to send out to volunteers. 
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Right click on the chart and select Copy from the options list. 

 

Open Microsoft Word and create a new blank document.  Note: you could at this point paste this chart in 

applications other than Word.  PowerPoint would be an example of one of these applications. 
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When the new Word document opens, click in the document space, right click and paste. 

 

Choose Page Layout and change the page orientation to Landscape. 
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Choose the File menu, Save As, then choose a location to store the new document.  Name your document and 

save the document as file type PDF.  This will create a PDF document of your chart.  This is a more secure 

document type to send via email. 
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The chart can now be opened in Adobe Acrobat Reader or your PDF reader of choice. 

 

Returning to Excel, select File, name the file and then save as an Excel workbook. 

 

Return to the Table of Contents 
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AgriLife Report 
In many chapters the AgriLife extension agents request monthly reporting.  These reports are generally 

focused on Outreach and Training and Educating Others opportunity categories.  The information that they 

typically need, are the number of opportunities, how many volunteers contributed service to these 

opportunities, how many hours of service, and how many people were touched or impacted by the activities at 

these opportunities. 

Log in to eCoordinator.  Choose your chapter folder.  In this example we’re using the Mid-Coast chapter.  

Select the Opportunity tab.  Select the TMN Standard AgriLife Training grid view from the Grid View dropdown 

list.    
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The TMN Standard AgriLife Training filter sets the chapter opportunities list to only include Public Outreach 

(Indirect) and Training and Educating Others (Direct).  Mid-Coast has 23 opportunities that meet these criteria.  

Click on the Log Book button and choose all opportunities in grid. 

 

We are preparing a quarterly report so the last 3 months of 2018 are selected for the date range (Oct, 1 2018 

to Dec, 31 2018).  Set the date range and click apply.  Check that summary mode is selected.  Choose TMN 

Standard – AgriLife Training from the Grid View dropdown list.  
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The resulting grid will typically satisfy the needs of the AgriLife Extension Agent.  Looking at the total line in this 

grid there were 10 opportunities tracking outreach and training.  365.25 service hours were contributed.  20 

volunteers contributing those hours.  

 

Scrolling to the right, we can see 1,016 people were impacted, 566 adults, and 450 youth.   

 

Return to the Table of Contents 
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Chapter Impact 
It is important to report to your chapter volunteers the impact that they have made as a chapter.  Log into 

eCoordinator and select your chapter folder.  Choose the Opportunities tab.  In this example we are using the 

Mid-Coast chapter folder.  Click on the Clear Filters button.  Click on the Log Book button and choose all 

opportunities in grid. 

 

Choose the date range for the period you want to report on.  We’re looking at January, 1 2016 to December 

31, 2016 in this example.  Click the Apply button to apply your date range to the grid.  Choose Summary mode.  

Select TMN Standard Reporting from the Grid View select dropdown list. 
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Scroll to the bottom of the grid to view the summary info row.  Looking at this row we see: 

Number of opportunities with hours reported 
Number of volunteers reporting 
Total number of Advanced Training hours 
Total number of Service hours 
Total number of Initial Training hours 
Total people impacted through outreach 
Acreage impacted 
New Trail Miles 
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By changing Relative Date Range and choosing All Time then clicking the Apply button we get cumulative 

chapter totals.   

 

Looking at the summary row, we see that the Mid-Coast has contributed 18,789.4 advanced training and 

183,077.26 service hours.  Use the Log book Data Grid Report to export the information. 

Return to the Table of Contents 
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Partner Reports 
Chapters often have partnership agreements with other organizations with whom they share volunteer service 

data.  The easiest way to capture service information for these partners is to set up special opportunities.  

Aransas National Wildlife Refuge (ANWR) is one of the Mid-Coast chapter’s partners.  The chapter has created 

an opportunity for each of the activity categories that volunteers contribute hours at the ANWR.  These are: 

FR: ANWR research 
RM: ANWR 
NPA: ANWR 
PO: ANWR 
TG: ANWR 
TR ANWR direct education 
 
These six opportunities capture the field research, resource management, nature/ public access, public 

outreach, technical guidance, and training activity that occurs at Welder.  Using common naming for partners 

makes it easy to select all of the opportunities that belong to that partner.  Let’s look at the contributions the 

Mid-Coast chapter made to ANWR in 2018. 

Begin by logging into eCoordinator and selecting your chapter folder.  In this example we’re working in the 

Mid-Coast folder.  Click the Clear Filters button to clear all filters. 

By Typing ANWR in the Find cell below the Opportunity Title column heading and clicking the Find button we 

can locate only the ANWR opportunities in the Mid-Coast opportunity list.  Manual selection of partner 

opportunities may be needed depending on how you name opportunities in your chapter. 

The result is the six ANWR opportunities.  Click the Log Book button.  In this case we choose all opportunities in 

grid.  If you are manually selecting opportunities you would choose only selected. 
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Choose the date range and click the Apply button.  Select Summary mode.  Choose the TMN Standard 

Reporting view to show the columns we need.   

The result is all of the volunteer and impact data that the chapter contributed to ANWR in 2018.  Change the 

date range to see chapter lifetime contributions to your partners.   Use the Log Book Data Grid Report to 

export the information and share it with your partners. 

 

Return to the Table of Contents 

Using the eCoordinator Combine Multiple Export Files Tool 
Often when exporting detail information from eCoordinator the export results in more than one file.   Use the 

eCoordinator File Combine Excel application to easily combine these files. 

Create a directory to store the export files.  Login to eCoordinator and create your export files (Text).  Save 

them to the directory created in the step above.  Copy the eCoordinatorFileCombine Excel file to the same 

directory.  
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Make a copy of the eCoordinatorFileCombine Excel file and rename it.  This will be your working copy of the 

file. 
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Open your working copy.  This file contains code to process your export files.  Because of this the Security 

warning will be shown the first time you open it.  Check the Enable Content button.  

 

The Combine Multiple eCoordinator Export Files window will open.  Click on the Browse button. 
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Locate the first export file and click on it.  Click on the OK button.  The first file is important because it contains 

the column headings used for all of the export files. 

 

Verify your selection in the first export file and Path of eCoordinator export files text boxes.  Note: The 

application expects that all of the export files to be processed are in the same directory as the first export file.  

Click on the Begin Processing Files button. 
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The Message section shows the progress of file processing.  When all files have been imported into Excel the 

“File processing complete” message is shown.  Click the OK button to continue. 

 

The data from all of the files is now in the eCoordinator worksheet.  Click the “X” in the top right of the window 

to close it and begin working with the data. 
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To reopen the window and process additional export file sets, select the eCoordinator Tab on the Ribbon Bar.  

Then click on the FIleCombine icon.  Note: Starting another file import will clear the contents of the 

eCoordinator worksheet. 

 

Return to the Table of Contents 
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